
Part Names and LCD Display

￼

 CO2 Sensor Area (Internal)
 LCD Display
 Infrared Communication Port 
 Operation Buttons

     Button
     Button
     Button

 Battery Cover
 Temperature and Humidity Sensor Jack
 AC Adaptor Jack
 USB Connector (Mini-B)
 Serial Connector
 External Alarm Terminal (EXT ALM)
  Switch	

[REC] Mark Shows recording status
ON: Recording in progress
BLINKING: Waiting for programmed start
OFF: Recording stopped

Data Scale At the beginning of every 2,000 readings the scale will be marked from left 
to right. Logging capacity is 8,000 readings.

[COM] Mark Shows communication status but not displayed normally.
ON: The unit is connected to a PC with a USB cable.
RAPID BLINKING: The unit is in communication with the computer via USB 
or infrared communication.

Recording 
Mode Recording mode settings can be made by using the supplied software.

Endless:     Upon reaching the logging capacity of 8,000 readings, the oldest data will 
be overwritten and recording will continue.

One Time: Upon reaching the logging capacity of 8,000 readings, recording will 
automatically stop and in the LCD the current measurement and the word 
“FULL” will alternately appear.

Battery Mark Shows source of power and voltage level
ON: Running on external power source
BLINKING: Running on battery power
OFF: No battery

Current 
Temperature 
and Humidity 
Readings Area

Shows the current readings for temperature ( °C or °F) and humidity (%RH). 
Pressing the  button will change the measurement item to be 
displayed. By using the supplied software, the unit of temperature can be 
changed. is also used to display messages.

Current CO2 
Readings Area

Shows the current readings for CO2 concentration (ppm).  is also used to 
display messages.

Button Operations

Upon the start of recording, all previously recorded data in the TR-76Ui will be deleted.

If "Button Lock" has been set to ON in the CO2 Recorder for Windows, the operational 
buttons will not be active.

 Button: Starting and Stopping Recording
Starting Recording

Press the  button for about two seconds until the [REC] 
mark appears on the display.
•	It is possible to start recording even while waiting for a 

programmed recording to start.
Stopping Recording

Press the  button for about two seconds until the [REC] 
mark disappears from the display.

 Button: Changing the LCD Display Pattern
It is possible to change the current readings display for temperature and 
humidity (upper row). CO2 concentration (lower row) is always displayed.
	.1With each pressing of the  button the item on the display will change.

Temperature and Humidity: The display will alternate every one second.
Temperature only
Humidity only

	.2When the desired display pattern appears, stop pressing the button.

 Button: Checking Recording Interval
It is possible to check the recording interval during recording or while 
waiting for a programmed recording to start.
	.1By pressing the  button for 

about two seconds, the currently set 
recording interval will appear on the 
LCD display.

	.2If no operation is carried out after the 
recording interval has been displayed, 
the current measurement readings will 
return to the LCD display.

10 minutes 10 seconds

 Button: Changing the Recording Interval Setting
Recording interval settings cannot be changed while a recording session is 
in progress.
	.1Stop recording.

	.2Press the  button for about two seconds to display the currently 
set recording interval on the LCD screen.

	.3With each pressing of the  button the recording interval time will 
change; stop pressing the button when the desired interval appears.

	.4Restart the recording session.

Package Contents
TR-76Ui TR-76Ui-S

	• CO2 Recorder TR-76Ui
	• Temperature and Humidity Sensor 
(THA-3001) 

	• AC Adaptor  (AD-06A1 or AD-06C1)  
	• USB Communication Cable 
(US-15C) 

	• Software CD-ROM
	• AA Alkaline battery x 4
	• Getting Started Guide (Warranty 
Included) 

	• Please Read First
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	• CO2 Recorder TR-76Ui
	• High Precision Temperature-
Humidity Sensor (SHA-3151) 

	• AC Adaptor  (AD-06A1 or AD-06C1) 
	• USB Communication Cable (US-
15C)

	• Software CD-ROM
	• AA Alkaline battery x 4
	• Getting Started Guide 
(Warranty Included)

	• Please Read First
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  Notes about Operation
This product has been designed for use in normal living conditions, and is not suited 
for controlled environments such as a CO2 incubator. When measuring outdoors, 
avoid exposure to sunlight, dust, rain, or wind. Also make sure to use in the operating 
environment indicated in the specifications.
This product cannot measure CO or O2. Do not use the unit for purposes such as 
avoiding O2 deficiency, CO intoxication or any other health related purpose.
For one to two weeks after installation of the TR-76Ui, CO2 concentration 
measurements may fluctuate suddenly. This is due to the normal operation of Auto 
Calibration and is not a malfunction of the unit.
Do not use or store the unit in areas exposed to direct sunlight and abrupt changes 
in temperature.

Do not allow the unit to become wet. Do not use or store the unit in places where 
condensation occurs.

To help prevent deterioration of the unit, do not use or store the unit in areas 
exposed to cigarette smoke, corrosive, explosive or organic gases or dust in the air.

Do not expose the unit to a strong impact. This will adversely affect measurement 
accuracy and may cause the case to break resulting in bodily injury.

The measurement accuracy of the CO2 sensor can not be guaranteed for CO2 
concentrations of 5,000ppm or more.
The Warning Monitoring function provided in the TR-76Ui is for informational 
purposes only. By clicking “I Agree” button you confirm your understanding that it is 
not to be relied upon for human health or safety.

Messages and Display on the LCD

Settings Messages
Button Lock

When "Button Lock" has been set to ON in 
CO2 Recorder for Windows, operational buttons are not 
active.

Memory Full
When recording mode has been set to “One Time” and the 
unit reaches its logging capacity of 8,000 readings, the 
measurement and the message [FULL] will alternately appear 
in the LCD.
Stop recording and download the recorded data before 
re-starting recording.

•	When this happens, measurement will continue so battery power will be consumed.

Notes on Special Functions

Getting Started Guide

Setting up the TR-76Ui
Make sure to install the provided software before connecting the TR-76Ui to your PC.

Connect the Temperature and Humidity Sensor

Turn On the Power

AC Adaptor
When measuring and recording over long periods of 
time, please use a supplied AC adaptor.

Four AA  Alkaline Batteries
Keeping batteries in the unit allows a backup source of 
power * for when and if electrical power is cut from the 
AC adaptor. If running on only batteries, the estimated 
battery life is about two days.

*	Leaving alkaline batteries in the unit for a long period of time may cause battery leakage and 
corrosion. When using as a backup source, we recommend that you change the batteries every 
few years.

Turn On the  Switch
After setting up the power supply, turn on the  
Switch.

"ON" 
position

Warm-up Time for CO2 Sensor
After switching on the unit, it will take about one minute to display the 
normal CO2 concentration.

Install the Batteries
If battery power is lost, all recorded data stored in the unit will be erased. Do not leave 
the unit without batteries.

	.1Remove the battery cover from the back 
of the unit.

 While pressing down on the triangular mark, 
slide the cover to the bottom of the unit.

 Lift off the cover.

	.2Insert the batteries.
•	Make sure to use four new batteries of the same 

kind.
•	Make sure not to mistake + / -.
•	Do not insert or change batteries with wet 

hands.
•	Be sure to completely close the cover.

Interpreting the Battery Mark

Checking the Power Supply Condition
Whether the battery mark is "blinking" or "on" indicates the source of 
power.
BLINKING (Running on battery):
The battery mark will blink on the LCD display when measuring and 
recording by battery power.

Mark blinks when running on 
battery power.

ON (Running on external power):
The battery mark will be on when measuring and recording by AC 
adaptor power.

Checking the Battery Level
The battery level will be shown in three stages as below.

 Battery Power - OK
 Battery Power - Getting Low

Please change the batteries as soon as possible.

 Battery Power - Too Low
Battery power is too low to carry out measurement 
and recording of CO2 concentration.

•	When running on batteries only, it will take about 24 hours to go from Stage  to  
and another 24 hours from Stage  to .

 Sleep Mode (stopping measurement and recording)
After Stage , if the battery is not changed but it remains in use, 
the unit will enter sleep mode and stop measurement and 
recording in order to protect recorded data until this point.
•	To continue recording, it is necessary to change the batteries 

before the unit enters sleep mode.
•	If the unit is already in sleep mode, download the recorded data 

into the PC before re-starting recording.
 Erasing recorded data

If the battery is further left unchanged, the display will 
automatically shut off and all previously recorded data will be lost.

Removing the Batteries during Recording
	.1If the batteries are removed when running on battery 

power only, the unit will start a sixty-second countdown.

	.2To continue recording, before the countdown comes to 
an end, insert new batteries or connect the AC adaptor 
to supply power.

Countdown

	.3If power is not supplied within 60 seconds, the unit will 
enter sleep mode.

Turning Off the  Switch
During recording or when the "Button Lock" is set to ON in the 
CO2 Recorder for Windows, the power cannot be turned off even by pressing the 

 Switch.

	.1Stop recording.

	.2Turn off the  Switch.

Standby Power
If the TR-76Ui is connected to an AC adaptor, standby power will be supplied 
even after turning off the  switch, allowing the CO2 sensor to 
continue operation.

Getting Ready for Using Infrared Communication
In order to download recorded data from the TR-76Ui via infrared 
communication, it is necessary to purchase the dedicated Data Collector 
TR-57DCi (sold separately).

•	Go to [  Operation Guide] to see how to download data via data collector.

Getting Ready for Using the Warning Monitoring Function
It is possible to connect an external device such as siren or lamp to the 
TR-76Ui. Please make sure to check specification details of the external alarm 
terminal before purchasing or getting an external device ready for 
connection.
Upper and Lower Limit Settings
To use the warning monitoring function, go to the [Start Recording] tab in 
the CO2 Recorder for Windows and make settings for Upper and Lower 
Limits and Judgment Time. When the measurement exceeds one of the set 
upper and lower limits, the TR-76Ui will turn ON the external alarm terminal. 
Upon a warning, the measurement value on the display will also flash.

About the External Alarm Terminal (EXT ALM)

Enabling 
Warnings

Warning Output 
(Enable / Disable)

Internal Pull-up: 3V 100kΩ
Maximum Input Voltage: 30V

GND

Warning 
Output
(OUT)

Output Terminal 
(Warning Output)

Open Drain Output
Voltage when OFF: DC less than 30V
Current when ON: less than 0.1A
Resistance when ON: 15Ω

GND

The connection between  and  decides whether 
Warning Output is enabled or disabled.
If a warning condition occurs while Warning Output is 
enabled, a connection between  and  will be established 
and a warning will be output.

Enabled Disabled

Alarm Connection Cable
The optional alarm connection cable (AC0101) is available. Please contact 
your local distributor for purchase.

Distributor List: tandd.com/purchasing/

When [ ] appears in the following:
Temperature and Humidity Display Area

This appears when the temperature-humidity sensor is not 
connected to the TR-76Ui, the connection is loose, the wire is 
broken, or when power has just been turned ON. If after 
re-connecting the sensor, measurements can still not be 
displayed, it is very possible that the sensor or the logger is 
defective or has been damaged.

CO2 Concentration Display Area
This appears when power has just been turned ON. If 
measurements don't appear in the display after waiting for a 
considerable time, there is a possibility that the sensor is 
defective or has been damaged. Also, the CO2 sensor will not 
work if battery power is low.

•	Measurement and recording will continue in this situation, so battery power will be 
consumed.

https://tandd.com
https://tandd.com/purchasing/


Printing the Graph
	.1While the graph is open, make any desired adjustments to the graph 

enlargement, position and aspect ratio to be reflected in the printed graph.

•	Graphs will be printed using the resolution and aspect ratio settings made for the Graph 
Display Area in Step 1 above. If you wish to change the resolution and/or aspect ratio, go 
back to Step 1 and make further adjustments based on the preview image. 

	.2From the [File] menu, click [Print Graph].

	.3By selecting the options on the toolbar in the Print Preview window, you can 
adjust the paper orientation, margin, items to be printed, etc.  
The graph title, items to be printed, and margin can be set in [Page Setup].

	.4Click the [Print] button.
•	For operational details of the T&D Graph, refer to the software Help.

Opening Data using Spreadsheet Software
It is possible to convert recorded data to a text file (CSV format) which can 
be read by common spreadsheet software.
	.1While the graph is open, click [Save in CSV Format] in the [File] menu.

	.2Specify the storage location, file name, and file type, then click the [Save] 
button.

•	For operational details of the spreadsheet software, refer to the software manual or help.

  Auto Calibration Function for CO2 Sensor 
The CO2 sensor has a calibration function (auto/manual calibration) to 
compensate for sensor drift that can occur over time.
Auto calibration is designed to enable long-term accurate measurements 
by gradually adjusting the lowest measured CO2 concentration over a 180 
hour period, to the global average concentration (atmospheric CO2 level 
of around 400 ppm). Please turn off auto calibration when continuously 
measuring in an environment where the CO2 concentration is always high 
or low. 

•	The factory default setting for auto calibration is ON.
•	The setting can be changed from the CO2 Recorder for Windows [Settings] menu 

- [Auto Calibration Settings]. For the operation procedures including manual 
calibration, refer to the [Operation Guide] - [Available Settings].

For more detailed information
Operation Guide:

Operation Guide contains detailed information about basic settings as well as details 
about advanced settings for many useful functions.  Access if from the Start Screen/
Menu or from the [Help] button in the application window.

Help for Unit Recognition Failure:
[Help for Unit Recognition Failure] contains detailed information about installing and 
checking the USB driver as mentioned in [Using the Software :   ].  Access is via 
the [Help] menu in CO2 Recorder for Windows.

Specifications
TR-76Ui TR-76Ui-S

Temperature-Humidity Sensor (External)

Sensor
THA-3001 SHA-3151(High-Precision Type)

Thermistor Polymer Resistance Thermistor Polymer Resistance
Measurement 
Channels Temperature 1ch Humidity 1ch Temperature 1ch Humidity 1ch

Units of 
Measurement °C, °F %RH °C, °F %RH

Measurement 
Range (*1) 0 to 55 °C 10 to 95 %RH -25 to 70 °C 0 to 99 %RH (*2)

Accuracy ±0.5 °C ±5 %RH
  at 25 °C, 50 %RH

±0.3°C 
  at 10 to 40 °C
±0.5°C 
  all other 
temperatures

±2.5 %RH 
  at 15 to 35 °C, 30 to 80 %RH

Measurement 
Resolution 0.1 °C 1 %RH 0.1 °C 0.1 %RH

Responsiveness Response Time (90%): Approx. 7 min. Response Time (90%): Approx. 7 min.

CO2 Sensor (Internal)

Sensor NDIR

Measurement 
Channels CO2 Concentration 1ch

Units of Measurement ppm

Measurement Range 0 to 9,999 ppm

Accuracy ±(50 ppm + 5 % of reading)  at 5,000 ppm or less (*3)

Measurement 
Resolution Minimum of 1 ppm

Responsiveness Response Time (90%): Approx. 1 min.

Unit Specifications 

Logging Capacity 8,000 data sets (One data set consists of readings for all channels in that type of unit.)

Recording Interval Select from 15 choices: 1, 2, 5, 10, 15, 20, 30 sec. or 1, 2, 5, 10, 15, 20, 30, 60 min.

Recording Mode Endless (Overwrite oldest data when capacity is full) or One Time (Stop recording when capacity is 
full)

Communication 
Interfaces

USB Communication (Mini-B connector)
Infrared Communication: IrPHY 1.2 low power (*4)
Serial Communication (*5)

External Alarm 
Terminal (*6)

Output Terminal: Open Drain Output (Voltage when OFF: DC less than 30V / Current when ON: less 
than 0.1A / Resistance when ON: about 15Ω)

Power AC Adaptor (AD-06A1 or AD-06C1), AA Alkaline LR6 Battery x 4

Battery Life Approx. 2 days ( batteries only without AC adaptor ) (*7)

Dimensions H 96 mm × W 66 mm × D 46 mm ( excluding protrusions and sensor )

Weight Approx. 120 g

Operating 
Environment Temperature: 0 to 45 °C, Humidity: 90 %RH or less ( no condensation )

Initial Settings Recording Mode: Endless, Recording Interval: 10 min.

Software (*8) PC Software (Windows)
CO2 Recorder for Windows, T&D Graph

*1: Make sure to use the data logger within the operating environment as listed in the specifications.
*2: When continually used in environments with temperatures above 60°C,  accuracy of humidity measurements will decrease 

over time. Also, humidity cannot be measured at temperatures below -20°C.
*3: Stated value is the measurement accuracy of the CO2 sensor when Auto Calibration is operating properly. A change in 

atmospheric pressure directly influences the reading of CO2, which can cause measurement errors; a decrease in pressure 
by 10 hPa results in a relative decrease in CO2 by 1.6%. In such a case, we recommend carrying out the “Atmospheric 
Pressure Correction” function found in CO2 Recorder for Windows.

*4: If you wish to use infrared communication to download recorded data, it is necessary to purchase the Data Collector TR-
57DCi (sold separately).

*5: Customers wishing to write their own software, please contact your local distributor for the serial communications protocol 
specifications. (Note: Optional serial communication cable TR-07C is also required.)

*6: In order to use the external alarm terminal, please purchase the optional alarm connection cable (AC0101).
*7: Battery life varies depending upon the ambient temperature in which it is used, the recording interval, the frequency of 

communication, and the battery performance. All estimates are based on operations carried out with a new battery and are 
in no way a guarantee of actual battery life. Battery life may be shortened if the unit is used under inverter type fluorescent 
lighting.

*8: Free software download and information on OS compatibility is available on the Software page of our website at tandd.com/
software/.

The specifications listed above are subject to change without notice.

Cautions about using the Temperature-Humidity Sensors

	- If extremely severe temperature changes occur, the humidity measurements may appear abnormal. 
Once the sensor’s temperature becomes stable, the measurements will return to normal.
	- Do not connect the sensor to any data logger other than those specified by T&D Corporation.
	- Do not expose the sensor to a strong impact. This may adversely affect measurement accuracy and 
cause damage or malfunction.
	- When the sensor is not to be used for a long period of time, please store it at normal temperature and 
humidity.
	- Do not allow the sensor to become wet. If the sensor gets wet, immediately remove it from the unit.
	- Do not use the sensor on the human body.
	- Do not expose to condensation, dampness, corrosive gases, or organic solvents.
	- Continued use may cause a decrease in the sensor’s accuracy and sensitivity even under normal 
operational conditions. If the sensor is being used in a bad environment (smoky or dusty places) it may 
be necessary to change the sensor sooner.
	- The SHA-3151 is not water resistant. If the sensor gets wet, immediately remove the sensor from the 
unit and wipe it with a clean cloth as soon as possible. Then allow the sensor to dry in normal room 
temperature before using it again.
	- When using the THA-3001/3151 in an environment where the humidity is under 30%RH, the 
measurements may sometimes fluctuate. This is not abnormal.

Options
Data Collector: TR-57DCi Wall Attachment: AT-76K1

For Infrared Communication

Accessories
USB Communication Cable (US-15C)
Serial Communication Cable (TR-6C10)
AAA Alkaline Battery x 2
Software CD-ROM

Material: Aluminum

Temperature-Humidity Sensor :  
THA-3151

Sensor Extension Cable:  
TR-1C30

Measurement Range: 
Temperature: 0 to 55 °C / Humidity 10 to 95 %RH (No 
condensation)
Cable Length: 1.5 m

For Temperature-Humidity Sensor  THA-3001/3151, SHA-3151
(Possible to use up to three extension cables per sensor)
Cable Length: 3m
Temperature Durability: -25 to 60 °C 
Material: Vinyl Coated Electrical Wire

 Install the Software
For installation of the supplied software, it is necessary to have Administrator (Computer 
Administrator) rights.

	.1Start Windows and place the CD-ROM into your CD or DVD drive.

	.2In a few seconds, the [Install Program] window will appear.

•	If the [Auto Play] window appears, click on 
[Run start.exe].

•	If the [Install Program] window does not 
automatically open, please open it by 
double clicking on the [start.exe] icon in 
your CD or DVD drive.

	.3Select “Install CO2 Recorder for Windows” and click the [Execute] button to 
start the installation. Follow the directions to install.

	.4If a window appears such as the one below during installation, click the [Install] 
button.

	.5After installation, "CO2 Recorder for Windows" will appear in the Windows Start 
Screen or Start Menu.

 Connect the TR-76Ui to a PC
	.1Connect the device with the supplied USB cable to your computer.  

The USB driver installation will start automatically.
•	It is not necessary to connect AC adaptor at this point.

	.2Open CO2 Recorder for Windows and confirm that the TR-76Ui icon appears in 
the main window.

•	If the icon does not appear, please check whether the USB driver has been properly 
installed. (Refer to  [  Help for Unit Recognition Failure] )

 Make Atmospheric Pressure Correction Settings
Measurement results of CO2 concentration are affected by atmospheric 
pressure. When high measurement accuracy is required, we recommend 
that Atmospheric Pressure Correction be carried out before a recording 
session is started.
	.1Connect a TR-76Ui to your PC and open CO2 Recorder for Windows.

	.2From the [Settings] Menu, select [Atmospheric Pressure Correction] to open 
the settings window.

Enter Atmospheric Pressure at 
Measurement Location:
Directly enter the pressure (hpa) in the 
[Atmospheric Pressure] field.
Calculate Atmospheric Pressure from 
Altitude:
This setting can also be made by having the 
software calculate the estimated pressure at the 
altitude (meters) entered by the user.

	.3Click the [Send Settings] button to transmit the settings to the TR-76Ui.

 Make Settings and Start Recording
Upon the start of recording, all previously recorded data in the TR-76Ui will be deleted.

	.1Connect a TR-76Ui to your PC and open CO2 Recorder for Windows.

	.2Make recording settings in the 
[Start Recording] tab window.

	.3Click the [Start Recording] button 
to transmit the settings to the 
TR-76Ui.

	.4Disconnect the TR-76Ui from the PC and place in the desired measurement 
location.

Recording Settings
Recording Start Date and Time

Programmed Start: Recording will begin on the set date and time. As the current date and time 
of your computer are used, make sure that your computer clock settings 
are correct.

Immediate Start: Recording will start when the [Start Recording] button is clicked.

Recording Mode
One Time: Upon reaching the logging capacity of 8,000 readings, recording will automatically 

stop.

Endless: Upon reaching the logging capacity of 8,000 readings, the oldest data will be 
overwritten and recording will continue.

Recording Interval
There are 15 choices for the recording interval. 
Below are some examples of recording interval and maximum recording time.
1 second (2 hr 13 min 20 sec) 10 minutes (55 days 13 hr 20 min 00 sec)
30 seconds (2 days 18 hr 40 min 00 sec) 15 minutes (83 days 8 hr 00 min 00 sec)
1 minute (5 days 13 hr 20 min 00 sec) 30 minutes (166 days 16 hr 00 min 00 sec)
5 minutes (27 days 18 hr 40 min 00 sec) 60 minutes (333 days 8 hr 00 min 00 sec)

 Download Recorded Data to a PC
Even after downloading recorded data, the data will remain in the TR-76Ui.

	.1Connect a TR-76Ui to your PC and open CO2 Recorder for Windows.

	.2In the [Download Recorded Data] tab window, click the [Download] button.

Here you can check the storage location 
and file name for the recorded data.

	.3When a completion message appears after downloading, click the [OK] button 
to view the graph for that data.

Storage Location of Recorded Data and File Name (Default Settings)
Documents (or My Documents)\TandD Corp\CO2 Recorder for Windows\Serial 
No.(folder)\Serial No.*+ Downloading Date and Time.thc
*	Serial No. can be found on the sticker attached to the logger.

 View and Print Graphs
Viewing Saved Data in Graph Form
	.1Open T&D Graph.

	.2From the [File] menu, click [Open].

	.3Select the desired file, and click the [Open] button to view the graph for that 
data.

Using the Software Do not connect a TR-76Ui to your computer until the software has been installed.

https://tandd.com/software/
https://tandd.com/software/

